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PREFACE

The Australian and New Zealand Standard Commodity Classification
(ANZSCC)1 has been produced by the Australian Bureau of Statistics (ABS)
and Statistics New Zealand (SNZ) for use in the collection and publication of
statistics in both countries. This follows other joint developments in Statistical
standards such as the Australian New Zealand Standard Industrial
Classification (ANZSIC)2.

The ANZSCC Coder is a computer assisted coder designed to assist clients to
code commodities to the appropriate ANZSCC category.

The coder comprises the software and data files necessary for use with the
WINDOWS operating system; it includes an in-built 'Help' facility.

The ANZSCC Coder will be periodically updated to include new commodities
and new index entries for existing commodities.

Clients having a need for a more detailed level of classification than that
provided by the standard classification and coder are encouraged to discuss
their requirements with the ABS or SNZ.

W. Mcl.ennan
Australian Statistician

L.W. Cook
Government Statistician

July 1997

Eoginpie
1. ABS Catalogue No. 1254.0, 1990, SNZ Catalogue No. 19.904.0085,1980
2 ABS Catalogue No. 1292.0. 1993, SNZ Catalogue No. 19.005.0092,1993
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Chapter 1: The ANZSCC Coder package

1.1 Introduction

1. The ANZSCC Coder is a computer based coding program designed to
assist clients to code commodities to the appropriate category of the Australian
and New Zealand Standard Commodity Classification {ANZSCC) (ABS
Catalogue No. 1254.0, SNZ Catalogue No. 19.904.0095).

2. The coder comprises the software and data files necessary for operation
in the WINDOWS environment. It has in-built 'Help' facility to supplement this
manual.

1.2 The Package
1. The package as supplied should comprise:

a) The ANZSCC Coder manual, which is the primary source of information
for installation and operation of the ANZSCC Coder;

b)  One (1) disk containing the ANZSCC Coder and the files necessary for
its installation;

c) A'site-licence’ agreement (unless this has already been forwarded
separately); and

d) Areply paid client registration brochure listing the basic range of
ANZSCC products.

2. Iif any of the above items are not included as part of this package please
contact either:

Classification Section, Statistics New Zealand {SNZ)
Australian Bureau of Statistics (ABS) Tel 0-3-3748700 or Fax 0-3-3748864
Tel (02) 6252 7468 or Fax {02) 6252 7788,

Postal addresses:

Australian Bureau of Statistics (ABS) Statistics New Zealand
Classification Section, Private Bag 4741

PO Box 10 Christchurch
Belconnen ACT 2616 New Zealand

PLEASE READ CHAPTER TWO OF THIS MANUAL CAREFULLY
BEFORE ATTEMPTING TO INSTALL THE ANZSCC CODER




Chapter 2: Installing the ANZSCC Coder

2.1. Pre Installation Check

1. The ANZSCC Coder can be loaded to either a stand-alone computer or
to a Local Area Network (LAN). [t has been designed to run in the Windows
environment and requires Microsoft Windows 3.1 or later. It wiil also run under
Windows 95.

2. The Coder programs are supplied on a standard 1.44 Megabyte, IBM
compatible, formatted 3.5 inch disk.

3. The Coder requires approximately 4 Megabytes of disk space once
loaded, so ensure that at least that much space is free on the destination drive.

4. The Coder installs from within Microsoft Windows. This needs to be
running on the machine to which the ANZSCC Coder is to be loaded.

5. The installation program allows the user to specify the drive and
directory to which the software will be loaded. To alter the default destination
drive and directory, CAABSCAC, see 2.2 Installation Procedure, below.

6. It is strongly recommended that you exit all programs except Windows
before attempting to load the Coder.

7. Using 'File Manéger' in WINDOWS 3.1, or "Explorer’ in WINDOWS 95,
check that the following files are on the disk supplied:

_1Binst16.ex_ anzscc.z
_isdel exa selup.exe
_setup.dil selup.ins
_setup.lib winscm .z

2.2 Installation Procedure
1. Ensure the Installation disk is inserted into the floppy drive.

2. Note: Up to the last step you can abort the installation program by
pressing the Escape key [Esc]. If you do decide to abort, see Section 2.3
Aborting the Installation Process for further instructions.

Windows 3.1 Installation:

3. Select Run from the File menu of the Program Manager and enter
drivel\setup.exe
where drive is the letter representing the floppy drive.

(Z=  Now go to step 8.



Windows 95 Installation:
4. Double click the "My Computer® icon, then the ‘Control Panel' icon:

i
My I:Computer Cotrol Panel
5. Double click the 'Add/Remove Programs’ icon: Add/Remove

Programs
to open the Add/Remove Programs Properties screen.

6. To install the ANZSCC Caoder, click on the Install button, 22688 and
follow the instructions. The install program is called Setup.exe and will
probably be in the A:\ drive.

R

: Run Installation Program

.up .exe

7. Click on the Finish button and the coder will now start to install.

8.  The first screen to appear is as foliows:

9, This screen simply provides a graphic dispiay of the preparation stage.
No user intervention is required.



10.  Once the setup screen has reached 100%, the following screen will
appear:

ANZ

11.  This screen verifies you want to load the Coder. Click Next to continue.

@: To abort, click Cancel or press the [Esc] key
and go to Section 2.3

12.  The next screen allows you to change the default drive and directory to
which the Coder Index files will be installed. If you do NOT want to install to
C:\ABSCAC, simply overtype with your preferred alternative. If you are not
sure of the directory name, click on the Browse button and follow the screens
to locate it.




13.  When you have the correct drive and directory names for the Coder
Index files in the Choose Destination Location screen , click on the Next
button.

14.  The Installation program will now prompt you for the location for the
Coder Software files. Again this can be changed by overtyping CAABSCAC
with your preferred alternative, or browsing to locate it.

Note: It is strongly recommended that both the Coder Index files and the
Coder Software files are tocated in the same directory. Users with several
ABS coders, however, may choose to store the Coder Software files once and
store each set of Coder Index files in a separate sub directory. The hard drive
space saving is minimal.

15. When you have the correct drive and directory names in the Choose
Destination Location screen for the Coder Software files, click on the Next
button.

16. The final user selection screen, the ANZSCC Coder Folder Location,
now appears. This tells the Installation program where to set up icons for the
Coder on your Windows desktop {i.e. Windows 95 Folder orWindows 3.1
Program Group) . If you want them added to a Folder or Program Group other
than the default ABS Coder, simply select from the pick list or overtype with
your alternative. Click on the Next button to proceed.

17.  The installation program now installs all the Coder files to the designated
drives and directories and displays a standard screen to show its progress.
You may stili select 'Cancel’ or use the [Esc] key to stop the installation
process. Otherwise, simply wait until installation is complete.

18.  Upon completion of the installation, the following screen appears:

 ANZSCC Coder Version 1.0

19.  Press the OK button to complete the installation.



2.3 Aborting the Installation Process

1. The installation can be discontinued at any stage by clicking on the
Cancel button of any screen, or using the Escape key [Esc]. The following
screen appears asking you to confirm your wish to abort the installation

process:

L E xit Setup

2. Choose the appropriate button.




Chapter 3: About the ANZSCC

3.1

Introduction

1. The Australian and New Zealand Standard Commodity Classification
(ABS Catalogue No. 1254.0, SNZ Catalogue No. 19.904.0095) is used in both
Australia and New Zealand as the standard for the collection and presentation
of commodity statistics. It replaces the Australian Standard Commeodity
Classification (Revised) — Transportable Goods (ASCC), which was in use, in
various forms, for many years.

2. Whereas the Australian and New Zealand Standard Industrial
Classification (ANZSIC) classifies businesses to industries according to their
predominant activity, the ANZSCC classifies goods and services (i.e.
commodities) which are the outputs of industries.

3. The ANZSCC foliows the structure of the Central Product Classification
(CPC) —the United Nations standard multipurpose commodity classification
covering all goods and services.

3.2 The Classification Structure

1. The first three levels of the ANZSCC represent the Section, Division
and Group level of the CPC international standard (with a few minor
exceptions). Lower levels of the classification reflect Australian and New
Zealand ciassification requirements. These levels are generically referred to as
items and can be five, seven or nine digits, depending upon the level of detail
required to uniquely identify a commaodity. Thus, for example, Steam and hot
wateris simply classified to code 173.00 whereas Delicious apples can be
classified to Pome fruit, apples, fresh, "Golden” (013.15.01.16}, "Ordinary”
(013.15.01.17) or "Red" (013.15.01.18). Care must therefore be taken when
coding to ensure the most detaited suitable level of classification is identified.

Example 1: Extract for Steam and hot water

Level ANZSCC code  Description

Section 1 ORES AND MINERALS; ELECTRICITY, GAS AND WATER
Division 17 ELECTRICITY, TOWN GAS, STEAM AND HOT WATER
Group 173 Steam and hot water

ANZSCC Item 173.00 — Steam and hot water



Example 2: Extract for Delicious apples

Level ANZSCC code  Description
Section 0 AGRICULTURE, FORESTRY AND FISHERY PRODUCTS
Division m PRODUCTS OF AGRICULTURE, HORTICULTURE AND MARKET GARDENING
Group 013 Fruit and nuts
013.15 — Pome fruit, Irash
013.156M1 —— Apples, fresh
ANZSCC Item 013150118 ——— Delicious —Golden
ANZSCC tem 013.15.01.17 ——— Delicious — Orcknary
ANZSCC llem 013150118 ——— Delicious — Red
2. It is not intended that the ANZSCC remain static at its detailed level.

New categories will be added as needs arise. The most detailed categories of
the ANZSCC (five, seven or nine digit) are determined by a combination of
factors. Primary among these factors are user requirements, however these
are balanced against data availability, collection cost (to both data providers
and the statistical agencies) and confidentiality. All commodity item codes are,
of course, subject to the requirement that they align with, at ieast, the Group
(three digit) level of the CPC.

3 The structure of the ANZSCC Classification is reflected in the
construction and presentation of the ANZSCC Coder. -

3.3 About the ANZSCC Coder

1. The ANZSCC Coder is a micro-computer based look-up too! that
operates in the WINDOWS environment. The software enables users to enter
all or part of a word, or a group of words, relating to a commodity description. It
then returns a list of one or more commodity descriptions to which that
description may be applicable. Selection of a particular description will activate
the next screen, with the ANZSCC category to which the selected description
relates highlighted. Selection of any ANZSCC categories displayed in this
screen results in the category code and full description being displayed, along
with the codes and descriptions for all higher leveis of the hierarchy relevant to
the selected ANZSCC category.

2. The index incorporated in the ANZSCC Coder is drawn from an
enhanced version of the ANZSCC Alphabetic Coding Index and the structured
ANZSCC classification itself. The Coder therefore searches all the text, at all
levels of the classification, plus additional index entries. This index will be
reviewed from time to time. Registered users of the ANZSCC coder package
will be notified, at the contact address shown on the registration form, of
updates as they become avaiiable.

3. If a commodity is not specified in the ANZSCC Coder, advice may be
sought from the ABS or SNZ (see page 3 for relevant contact details). Inquiries
of this nature are welcomed as they are a primary source of future updates.
However, particularly in the case of complex queries, Australian Federal
Government policy is that a charge may be levied for the cost incurred to
research and advise on specific cases.
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4. Clients having a need for a more detailed ievei of classification than
that provided by the standard coder are encouraged to discuss the advantages
of having the ABS build an index tailored to their specific needs.

5. For detailed instructions on commaodity searching in the ANZSCC
Coder see Chapter 4: Using The ANZSCC Coder.

3.4 The Help Facility

1. The ANZSCC Coder includes an in-built 'HELP' facility to compliment
the information provided in this manual. Help options can be displayed by
selecting Help at the top of the ANZSCC Coder screen, which results in the full
menu being displayed, or by pressing the <F1> key which results in context-
sensitive help being displayed.

2. The 'HELP' currently available provides information on the ANZSCC
Coder. Itis, however, only partially context-sensitive (i.e. it is capable of
recognising the general position of the user within the ANZSCC Coder
environment, but is not highly sensitive to the user's specific needs). For full

details on which features are incorporated in the current 'HELP', see Appendix
2: Menu Commands.

3. A tutorial on commodity coding is included in this Manual (Appendix 1:
ANZSCC Coding Tutorial). A tutorial is not included as part of the software of
the ANZSCC Coder. If clients believe their staff would benefit from a full
training session on the use of the coder, they are invited to contact the Director,
Classification Section, at the address shown on page 3, who will be happy to
discuss available options and their costs.

11



Chapter 4: Using The ANZSCC Coder
4.1 Introduction
The Coder Screens

1. In its 'standard’ form the ANZSCC Coder takes the user through
three basic screen types.

The [Commodity Search] screen is presented when the coder is

first activated and is the screen in which a new search is initiated.
In this screen the user enters their initial keyword(s). The screen
then displays the results of that initial keyword search. i allows the
user to further refine the search based on matches against the
Classification and associated indexes.

The [Classification Hierarchy] screen displays the ANZSCC code

and description for the commodity selected. Expansion symbols
are inciuded to indicate whether further levels of detail exist. This
allows the user access to the more detailed ANZSCC codes
required to progressively refine their choices until they correctly and
uniguely classify a commaodity.

The [Classification Item Description] screen displays the

ANZSCC selected from the previous screen, along with associated
higher ievels of the hierarchy, according to the level at which you
selected your search item. This presentation is particularty
important in that it allows detailed items to be read in context. The
upper levels of the hierarchy often provide valuable information
about the scope of the detailed item.

2. These screens are dealt with in greater detail in subsequent pages.
3. The tutorial at Appendix 1 contains examples of typical usage of the
coder.

Abbreviations and other usages
Abbreviations used in the ANZSCC Coder:

n.e.c. — "not elsewhere classified"
Expansion symbols in the hierarchy tree have the following meanings:

— further detail availabie — not expanded, click on the plus
symbol to further expand that item.

E] — further detail available — already expanded, click on the
minus symbol to minimise that item.

[ — finest level of detail available for that commodity.

12



Coder display of ANZSCC codes:

Due to system limitations, all codes are displayed as 9 digit numbers, zero
filled to the right and with the dot point separators suppressed. For
example, 389.22.05 displays as 389220500 in the coder window.

4.2 Opening the ANZSCC Coder

1. It is assumed you have already loaded the ANZSCC Coder as per
the instructions in Chapter 2. To open the ANZSCC Coder, select the
Program Manager Group or WINDOWS 95 Start Menu Folder you specified
at the "ANZSCC Coder Folder Location” screen and double click on the
ANZSCC Coder icon. This brings up the screen in which you start a new
search.

Commodity Search

Commodity

2. This screen is actually two separate windows, the background
window, ANZSCC Version 1.0, and the Commodity Search window. Both
these windows are user sizeable and will display standard horizontal and
vertical scroll bars if their current size exceeds the available display space.
Both windows can be maximised if the user desires. (For more information,
refer to your standard Windows system Heilp.)

3. Searches can be conducted by entering either full or part
descriptions of desired commodities as described below.

4. At any time, as you progress through a search, pressing the [Esc]
key or clicking on the Cancel button, [CEaaest. 1, Will close the current
screen and take you back to the previous screen This will aliow you to
examine a different item on that earlier screen if you are not satisfied with
the results of your last choice.

13




4.3 Searching by Description

1. The first step is to enter a 'string’ of characters in the Commodity
field. For example, to determine the ANZSCC code for "paint brushes”, the
following procedures may be used.

2. Type the word brush in the Commodity box then press the
<Enter>key or click the [Search] button at the bottom of the screen. The
Coder will search the index files and display the results of that search.

Commodity Search

Commaodity |brush

:1Brushes and brush wear
:iBrushes being part for machines. appliances ot
| vehicles

|Bruzhes For personal use excl tooth brushes
Brushes. electric motors, generators and plant
Brushware

Brushwoods and scrubwoods

Paint and varnish brushes

Scrubbing bruches

:215trip brushes

LR

AR R R AR AR

3. You can scroll up or down this screen if the number of Commodity
entries displayed by the ANZSCC Coder fills more than one screen (as in
this case).

4, To select the coder entry best describing your commodity (in this
case Paint brushes), highlight your selection and either press the <Enter>
key or click on the [OK] button at the bottom. This will bring up the next
screen which dispiays the item code {shown against the tag ANZSCC: )
and the description for the item selected in the previous screen. Generally
the description will be at the top of the screen and highlighted. You should
always read the entire description and re-assure yourself it is relevant to
the commodity you are classifying.

14



Classification Hierarchy

ANZSCC: 389220060

. fBrooms. brushes, hand-operated
tmechanical floor sweepers [not
imotornised]. mops and feather
dusters. prepared knots and tufts BN
fo1 broom of brush making:; paint
ipads and rollers; squeegees [excl
qoller squeeqees

— [ Cigarette lighters and other
lighters, whether or not
mechanical or electnical

— [ Roughly shaped blocks of wood
root, for the mal_'lulac!l.lre of pipes

S Th

5. The plus symbol, ] indicates that a further level (or levels) of
detail exist(s) (i.e. the item is broken down into even lower level items).
Double clicking on the plus symbol expands the next level of the hierarchy.
Note that the coder is designed to return entries at this level where more
than one coding option is possible within the level selected. In this case
there are a number of ANZSCC items below the selected level containing
the word "brush”.

6. Having expanded the level displayed, examine all the options and
select the most appropriate description. Again, this may involve scrolling
down to view all the options. Depending upon the current size of your
Coder window, the correct item may or may not be highlighted in the new
window. On the larger windows, the selection expanded remains
highiighted. On the smaller windows, the first item within the expanded
level is highlighted.

15



7. For our 'brush’ examples, "Floor mops” appears at the top of the
next window, and the entry for 'paint and varnish brushes' is contained
further down in the window. There will be instances, however, where the
description you have just expanded is still highlighted and/or you will have
to scroll down to locate the appropriate entry.

§ ANZS CC Versmn 1.0 - [Classification Hi..

ANZSCC:

389220100

— # Brushes and hrush ware [excl paint
and varnish brushes and for personal’
use]

— {1 Hand operated mechanical fleor
sweepers

— 7] Paint and varnisk brushes

L ] Commleie

8. Clicking once on the desired entry, ie Paint and varnish brushes,
to highlight it, brings up the relevant ANZSCC code as shown in the screen
below.

& Classification Hierarchy
ANZSCC: 389220500

— % Brooms

— B Brushes and brush waie [excl
paint and varmnish brushes and fo-
personal use]

— % Hand operated mechanical flaor -
sweepers

ml =8 aint and vamish biushes

— |2 Complete paint rollers,
replacements. accessones and
parts

|- [} Tooth brushes

L & Biushes for personal use [excl

16



9. The Classification ltem Description screen can be accessed at
any time by clicking the More button L¥#2d having selected any ANZSCC
description from the Classification Hlerarchy screen. Where the
description selected has a stop symbol, [-], beside the entry, double
clicking on the entry will also activate this screen.

10. The Classification ltem Description Screen displays a summary
of the ANZSCC structure for descriptions, as illustrated by the following
example of for Paint and varnish brushes:

{369270500

Eg 3 OTHER TRANSPORTABLE GODDS, EXCEPT METAL PRODUCTS.
SMACHINERY AND EQUIPMENT

38 FURMITURE; OTHER TRANSPORTASBLE GOODS N.E.C.

389 - Other manufactured articles n.e_c. -

; 389220000 ---Brooms. brushes, hand-operated mechamcal flootd
sweepers [not motorised], mops and feather dusters; prepared knots and
Htufts for broom or brush making; paint pads and rollers; squeegees [excl §

Jroller squeegees]

389220500 ----Paint and vamish brushes

11. This screen displays the item you have selected along with all
associated higher levels of the hierarchy. This presentation is particularly
important in that it allows detailed items to be read in context. The upper
levels of the hierarchy often provide valuable information about the scope
of the detailed item.

12. If no further information or vermcatson of the ANZSCC code is
required, click on the Accept button, [ZazeEst 1. at the bottom of the
screen. This will return you to the Commodlty Search screen. If this was
your last search in this session, you can exit the ANZSCC Coder program
in the normal manner for your Windows system.

17



13. If you think a different commodity item on one of the earlier
screens in the current search may have been more relevant, the Coder
still retains that screen without you having to redo the entire search
Pressing the [Esc] key or clicking on the Cancel button, 7, will
close the current screen and take you back to the previous screen.

4.4 No Match is Found

1. There may be instances when the ANZSCC Coder is not able to
find a match for the 'string’ of characters entered. If this occurs the
following screen appears:

2. If no match is found:

-- check that the spelling of the entry is correct
— try alternative spellings

— try using either fewer characters {e.g. change plural to
singular)

— try using a synonym or a generic term
— try a commodity that you think is similar.




Appendix 1 — ANZSCC Coding Tutorial

1.

Commodity Classification and the ANZSCC

1. The ANZSCG presents commodity categories for transportable goods
and non-transportable goods and services within a complete classification. The
categories are exhaustive, as well as mutually exclusive.

2. Commodities, that is goods and services, are the outputs of industries.
Goods are grown, mined or manufactured; and services are the intangible
outputs of industries.

3. In the development of the ANZSCC emphasis was placed on alignment
with international standards. The Central Product Classification (CPC) (UN
Statistical Papers, Series M, No. 77) provides the basis of the classification and
links are provided to other international standard classifications. This is to aid
the comparability of commodity statistics nationally and internationally. Ata

minimum, the ANZSCC aligns with CPC categories at the Group (three digit)
level.

4. The ANZSCC, therefore, provides a mechanism for coding goods and
services (commodities) within an internationally accepted framework.

Structure of the ANZSCC

1. The ANZSCC follows the structure of the CPC to its Group (three digit)
level. There are three exceptions' to that rule. Ail exceptions are either
aggregations or disaggregations of GPC Groups, and result from important
user requirements or local data supply constraints.

2. The first three levels of the ANZSCC are called Section {first digit of the
code). Division {first two digits) and Group (first three digits) respectively. The
next three levels (first five digits, first seven digits, ail nine digits) are simply
referred to as ANZSCC items.

19



3. There are ten Sections within the ANZSCC hierarchy. Sections 0

through 4 refer 1o the 'transportable goods', Sections 5 through 9 deal with the
‘non-transportable goods and services'. They are:

0 AGRICULTURE, FORESTRY AND FISHERY PRODUCTS
1 ORES AND MINERALS; ELECTRICITY, GAS AND WATER

2 FOOD PRODUCTS, BEVERAGES AND TOBACCQ; TEXTILES, APPAREL AND
LEATHER PRODUCTS

3 OTHER TRANSPORTABLE GOODS, EXCEPT METAL PRODUCTS, MACHINERY
AND EQUIPMENT

4 METAL PRODUCTS, MACHINERY AND EQUIPMENT

5 CONSTRUCTION WORK AND CONSTRUCTIONS

6 TRADE SERVICES; HOTEL AND RESTAURANT SERVICES

7 TRANSPORT, STORAGE AND COMMUNICATIONS SERVICES

8 BUSINESS SERVICES; AGRICULTURAL, MINING AND MANUFACTURING
SERVICES

9 COMMUNITY, SOCIAL AND PERSONAL SERVICES

There are 69 Divisions and 289 Groups within the ANZSCC hierarchy.

ANZSCC 328 'Newspapers, journals and periadicals’ was created of CPCs 323 ‘Newspapers,
foumals and periodicals, appearing at least four times a week' and 324 'Newspapers, journals
and periodicals, appearing less than four times a week';

ANZSCC 297 'Footwear, with outer soles and uppers of rubber or plastics, or with uppers of
leather or textile materials {including protective, sport and miscellaneous special footwear)
{excluding skating boots, asbestos and orthopaedic footwear)'; 'Paris of footwear' was created,
consisting of CPCs 293 'Footwear with outer soles and uppers of rubber or plastics, or with
uppers of leather or textile materials, other than sports footwear, footwear incorporating a
protective metal toe-cap or miscellaneous special footwear', 294 'Sports footwear, except
skating boots' 295 'Other footwear, except asbestos footwear, orthopaedic footwear and skating
boots' and 296 'Parts for footwear, removable in-soles, heel cushions and similar articles;
gaiters, leggings and similar articles, and parts thereof';; CPC 531 'Agricultural land, forest and

other wooded land’ was split to create ANZSCC's 534 "Agricultural tand’ and 535 ‘Forest and
other wooded land'.

20



3.

4.

4.1 Commodity searching

Obijective of the Tutorial

1. The objective of this section of the ANZSCC Coder Manual! is to provide
users with the necessary background to accurately undertake COMMODITY
CODING.

2. This tutorial is not intended to replace a formal training session, but
rather to provide individuals who have littie or no prior experience in
COMMODITY CODING with the basic skills.

Commodity Coding and the ANZSCC Coder

1. The objective of COMMODITY CODING is to assign appropriate
commaodity codes to goods and services. The function of the ANZSCC Coder
is to provide a computer assisted means whereby this can be done on the
basis of commodity descriptions.

1. In most instances, this will simply involve entering a search string (a
word, or part of a word), in the Commodity box of the Commodity Search
window.

2. As an example, if you wish to find an entry for "electronic whiteboards",
the search string "elec white" will produce the following result;

3. In the above example there is only one description to choose from.
Therefore, you can safely proceed through the following screens to obtain the
correct ANZSCC code and description.
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4. In most cases, however, multiple entries will be returned. For example,
if you enter "communication cables” at the Commaodity prompt, multiple
entries with "communication cables" as part of their description appear on the
screen, as can be seen in the following example:

§ 50 ANZSCC Version 1.0 - {Commodity Search

Commodity commumication cables

Coaxial cemmunicaiions cables, produced by this business afi
see also 62221 22 above
{Communicatien cables
|Communication cables, coaxial

| Conununication cables, fibre optic
fCommunil:".aﬁon cahles, other
{Communication cables, twisied pair copper

5. This screen presents but a few of the entries returned by the Coder. The
remainder may be viewed by scrolling up or down. The entries represent all
ANZSGC items with the words "communication cables” in their description,

from which a choice can be made to select the most appropriate option.

6. The list of entries in this screen would be substantially longer or shorter if
less or more words were entered. Using "cables” as an example, the following
entries would appear:

L. ommodity Seaich | {533 %] ;

iiCables, not insulated, metal wk
{Cahles, textile

{Ceaxial communications cables, ot produced by this

Hbusiness see also 622.21.22 above

| Coaxial communications cables,produced by this business

Hsee also 62221 .22 ahove

;('ummu.n.iralion cahles
I Communication cables, coaxial

{{ Comumuication cables, flbre optic
{{Comumnunication cables, other

7. In general, the more detail entered at the Commodity prompt, the fewer
the entries returned, and the greater the likelihood of finding a suitable
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ANZSCC item at the first attempt. Conversely, the lesser the detail (shorter
search strings) entered at the Commodity prompt, the greater the likelihood of
multiple entries being returned. Experience will enable users to strike a
balance enabling accurate, but timely, ANZSCC coding.

4.2 Selecting appropriate codes from multiple hits’
1. There will be many instances where multipie "hits" will be returned from
the commodity prompt.

2. As an example, suppose there is a need to find the ANZSCC code for
"folders™. Enter “folders” at the Commaodity prompt and the following entries
will appear:

fnldem , file covers, book covers, interleaved carbon seis and similar articles of
{paper or paperhoard statienery :

Further searching, by selecting the first or third options and pressing
i or <Enter>, will resuit in the following screen:

albums, hlotting -pads , folders. file covers, hook covers,
terleaved carhon sets and similar articles of paper or
hapetheard stationery

— {# Composed type,prepared printing plates or cylinders,
impressed lithographic sitones or other inmpressed media for
use in printing

4. Similarly selecting the second option takes you to the following screen:
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ANZSCC: 369310000

li ..............
Other plastic products ne.c.

| @ GLASS AND GLASS PRODUCTS AND OTHER NON-
METALLIC PRODUCTS NE.C.

- [ FURNITURE; OTHER TRANSPORTABLE GOODS NE.C.
— B WASTES OR SCRAPS

5. Comparing the ANZSCC codes reveals "folders” are classified to two
different parts of the ANZSCC, depending upon whether or not they are made
of plastic. Following the steps detailed in 4.3 Understanding the hierarchy
will reveal that the folders would be coded as follows:

Plastic folders would be coded to ANZSCC itemn 369.31
and

Paper and paperboard folders would be coded to ANZSCC item 326.02.90

6. This simple example demonstrates the need to examine all options.

4.3 Understanding the hierarchy

1. To better understand the hierarchical structure of the ANZSCC let us
have a look at where, as an example, "motor vehicles” fit within that hierarchy.

2. Entering "motor vehicles” at the Commodity prompt will activate a
screen containing all entries in the coder with the term "motor vehicles” in their
description. Scrolling through the entries will bring the following entries into
view:




4 Camonodity [motor vehicles

it

‘{Maintenance and repair services of metor vehicles
: l‘i'lanu.&cture of motor vehicles, trailexrs and semi-trailers, on a fee or coniract

gNoior cars and other moior vehicles principally designed for the iransport of less
than 10 persons incl station wagens and racing cars excl public-transport hvpe
Evehicles

‘IMotor vehicles for the transport ofmls andspecose motor vehicles
;;P.llntnr wehicles, paris and accessories, sales
{Moior vehicles, passenger, less than 10 people

H

3. In this example, the highlighted description of "Motor cars and other
vehicles principally designed for the transport of less than 10 persons [including
station wagons and racing cars] [excluding public-transport type vehicles]” has
been selected as most appropriate from the Commodity search. Selecting

or pressing <Enter> will now activate the following screen:

ANZSCC: 491030000

iransport of less than 10 persons [incl station wagons and racing c:
fexcl public- transport hvpe vehicles

— B Motor vehicles for the transpert of geods and special purpose moior
vehicles

L b Paris and accessories of motor vehicles n.e.c.

— ¥ Bodies {coaclwork] for motor vehicles; trailers and semi-trailers; parts
and accessories thereof

— B Ships
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4, Double-clicking on the [&] sign will reveal the next level of the hierarchy,
and so on until the final level of hierarchy is reached. In this example, double-

clicking on the 0 sign will produce the following screen:

QNZSCC Vemnn 1 [I

{Eldsmhcallnn Hlelalchp]

ANZSCC: 491030000

B lowor cars and other motor vekicles principally designed for the

— i Assembled cars
— (] Assembled station wagons

— [ Other assembled motor vehicles [eg mini- buses,passenger miwi-
WLllSI [specify type]

L [5] Unassembled motor vehicles, complete

5. A selection can now be made from the options at the most detailed level
of the hierarchy.

6. At this stage, if we were convmced that the item highlighted was correct,
we could doubie click on the &ssep ] button and return to the Commodity
Search screen.
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7. If we wish to view the full hierarchy to ensure the sification is correct,

1491030100

{4 METAL PRODUCTS, MACHINERY AND EQUIPMENT

49 -TRANSPORT EQUIPMENT

491 --Mouior vehicles, trailers and semi-irailers; paris amd accessories thereof
491030000 ---Motor cars and oither motor vehirles principally designed for the

jtransport of less than 10 persons [inc] station wagons and racing cars] jexcl public-
{transport type vehicles]

1491030100 . Assembled cars

This screen displays the full classification hierarchy for the item selected,
where:

SECTION 4 =  METAL PRODUCTS, MACHINERY AND EQUIPMENT
DIVISION 49 =  TRANSPORT EQUIPMENT
Group 491 = Motor vehicles, trailers and semi-trailers; parts and

accessories thereof

tem 491.03 = Motor cars and other motor vehicles principally
designed for the transport of less than 10 persons
Item 491.03.01 =  Assembled cars

This screen is provided to allow the user to see, at a glance, the full context of
the detailed item selected.
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4.4 No Matches Found

By now, from working through the above examples, it will be evident that when
a string of aiphabetic characters is entered at the Commodity prompt, a
commodity description (or descriptions) will be displayed. However, there will
be instances where no match can be found, and the following screen will
appear:

Win Coder

If no match is found:

- check that the spelling of the entry is correct

— try alternative spellings

- try using either fewer characters (e.g. change plural to singular)
- try using a synonym or a generic term

- try a commodity that you think is similar.
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5.

Use the ANZSCC Coder to complete the following exercises

Exercises

exercises can be found on the next page.

Exercise 1

Find the ANZSCC code for the following commodities:

1.

© N @ oA N

Salt (crude)

Meat pies

Electronic whiteboard

Database services

Computer hardware maintenance
Computer software maintenance
Family law services

Taxation services

Exercise 2

Find all the ANZSCC codes for "sugar" and "sugar cane”.

Exercise 3

. Answers to the

Which ANZSCC Section (one-digit), Division {two-digit level) and Group (three-
digit) would "Architect services” be assigned to?

29



6. Answers to Exercises on the previous page.
Exercise 1

16213
21134
45104
84400
84510
84202
86114
86300

NN

Exercise 2

Sugar:

Cane sugar, raw 23511
Icing sugar 23512
Refined sugar in solid form 23513
Molasses (incl treacle) 23514
Sugar n.e.c. 23590

Sugar cane:

Sugar cane cut for crushing 01801
Sugar cane, cut for plants 01506

Exercise 3

ANZSCC Section 8 '‘Business services; agricultural mining and
manufacturing services'

ANZSCC Division 86 ’Legal, accounting, auditing and book-keeping
services; taxation services; market research and public
opinion polling services; management and consulting
services; architectural, engineering and other technical
services'

ANZSCC Group 867  'Architectural, engineering and other technical
services'
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Appendix 2 - Menu Commands

3.
3.1 The File Menu

This part of the Manual is for users who wish to understand the options
provided by the ANZSCC Coder and for those unfamiliar with other
WINDOWS based applications.

Introduction

1. When the ANZSCC Coder is installed, a standard set of screen displays,
suiting most user requirements, is incorporated. However, some screen
displays may be modified to accommodate individual preferences.

Overview of Menu Options

1. The function buttons at the bottom of the Commodity Search screen
have already been detailed in Chapter 4 USING THE ANZSCC Coder (page
12).

2. This part of the Manual deals with the 'puil-down’ menu options at the
top of the screen (i.e. File, Options, View, Window and Help) and the
subsequent range of options within.

Menu Options
1. The File option allows the user to select the file required to access the
ANZSCC Coder.

2. Selecting File will result in the File 'pull-down’ menu being displayed and
the following screen being presented:
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3. As the screen image shows, there are four (4) options available, other
than Exit and the file currently in use (s:\coders\anzscc\ANZSCC.spc in this
exampie).

3.1.1 File \ New

4. New is used to select the relevant coding index and classification data.

It can also be used to modify the appearance of the hierarchy screen and the

number of screens that are able to be activated. Selecting File\New results in
the Coding Specifier screen being presented:

Luding Spechier

: ) i
i dentity the coding date siores to be used and set options as raquired.
LI Coding Index

 Nemo:  [EIOEHE

Location: |5:'\mders\nnzscc\

Name: [aNZSCC

_ | Location. [s:\coders\anzscey

Neme: [anzscc

Location: |€I\¢oder3\nnrscc\

oo NUmMerie Bndeac: e

Namse: |
Locatian: |

5. Selecting :

(Coding Index) results in the Browse screen being
presented:

24 sy
%@y coders
iy anzsee

N.B. Contents of the boxes under File Name: and Folders: can vary.
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6. This screen allows the user to search for Coding Index files (those with
tmt or .mdf extensions) relevant to their needs. The ANZSCC Coder only
uses .md! files.

7. Selecting l8@¥&. (Classification Data) allows the user to search for
Classification Data f:les (those with .dat or .ixt extensions) relevant to their
needs:

{ <A coders
34 anzscc

8. Selecting & J from the Coding Specifier screen results in the
following Classification Dlsplay Options screen being presented:

~Classn Structure —-~-  ~Definitions -

P

" None {*None

£t Dipstetiis & Item Definitions

" Item Hierarchy ¥ Accept Code From
- | CFull Hierarchy -
. @Expandable Hierarchyl | - Numseic inde o
. | ¥ Accept Code From  ®tione
: L Mumens lefex
" Aliow Search
T Accept Code From
i¥.Confirm Code Accept f" AcaptLoge Fros
B Acnees spfinibons
% Otions User Alterable ?f"’m spes frow Delindlon

9, This screen allows the user to set display parameters when 'returning’
coding information (but only if the Options User Alterable check box is ticked).
The Options User Alterable check box indicates whether or not this
information can be modified by the user during a session.




10.  The first section, headed Classn Structure, has several options. The
meaning of each is set out below.

None Once a Commodity has been selected its code is
automatically returned to the program that called the
ANZSCC Coder. This only applies to systems in
which the ANZSCC Coder is a sub-system.

Item Hierarchy Displays classification information particular to the
item selected, if available.

Full Hierarchy Displays the classification information in the context
of the entire classification hierarchy. This allows
selection of a different code if required;

Expandable Hierarchy Displays the classification information in an
expandable hierarchy. Double clicking an item with

] sign reveals the next level of hierarchy below.

Double clicking on Ecompresses the hierarchy to
the next level above.

11, The second section headed Definitions has two options. If either Item
Hierarchy, Full Hierarchy or Expandable Hierarchy were selected in the first
section and data are availabie, then selecting item Definitions will display the

text description as an optional window, accessed by selecting L
Item Definitions are not required, then None may be selected.

3.1.2 File \ Open
12.  Selecting File \ Open results in the Open screen being presented:

N.B. Contents of the boxes under File Name: and Folders: can vary.
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13.  This optian would only be used if multiple indexes or customised coding
screens were available.

3.1.3 File \ Save As
14.  Selecting File \ Save As results in the Save As screen being presented:

RS OU SN

¢ anzscc

N.B. Contents of the boxes under File Name: and Folders: can vary.

15.  This screen allows the user to save display parameters, set under the
File\New\Display option. Saving the changes to a file other than "anzscc.spc’
(e.g. anzsccl.spe) allows a number of customised coding screens to be
invoked when the ANZSCC Coder is initialised.

3.1.4File \ Information

16.  Selecting File \ Information results in the CAC Index File Information
screen being presented:

AL Index e Informabon

Coding Specihication File
: i s:\coders\anzscclanzscoc.spc
: 1 27 Mar 1997 14:19:12

Coding Index File

s:\coders\anzsceyanzsce mdf
.| 26 Feb 1997 11:47:4
| Index Title: ANZSCC Version 1.0

i Classilication Data

| Classification hierarchy fila
s:\coders\anzscclanzscc.dal
20 Mar 1997 16:33:48

Full text description file
s \coders\anzscchanrsce txt
20 Mar 1997 16:34:10

Numaric Index File
.| {None)




17. The File \ Information command is used to list the dates, file names and
types of files used by the ANZSCC Coder.

3.2 The Options Menu
18.  Selecting Options results in the following menu being displayed:

19  There are three options under Options. 'Indexing' and 'Exact Match' are
not accessible at this stage. The Classn Display option may or may not be
shown at this stage. This depends on whether changes have been made to the
display parameters set under File\New\Display option. Creation of this option
is covered under Options \ Classn Display (page 37).

3.2.1 Options \ Structured

20.  Structured is the first available option. When flagged, it indicates
whether the classification in use is structured or not. As the ANZSCC
classification is structured, this flag cannot be changed.




3.2.20ptions \ Font

21. Font is the second available option. It is used to change the font of the
characters displayed throughout the ANZSCC Coder. Selecting Font resuits in
the Font screen being presented:

Boid halic

22.  As with any other WINDOWS package, select the font, font style, size
and L

3.2.30ptions \ Classn Display

23. If the ANZSCC Coder was installed as detailed in Chapter 2
INSTALLING THE ANZSCC Coder and the Option User Alterable box has
not been ticked using the File\New\Dispiay option, then the Classn Display
option will not appear as one of the options under Options and must therefore
be created.

24  This can be done by first selecting File\New which results in the Coding
Specifier pop-up screen being presented.

- Selection of (S84 results in the Classification Display Options
pop-up screen being presented.

- Select Options User Alterable, then select d to clear the
pop-up.

- Finally select L don the Coding Specifier screen to clear the
Pop-up.
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25.  The standard ANZSCC Coder opening screen will now be displayed and
Classn Display will now appear as one of the options under Options.

26.  If these procedures have been followed correctly the following pop-up
will appear when the ANZSCC Coder is closed:

.Coding Specifications

27

Coder for future use then select 3, which will result in the Save As
screen being presented:

Coding Specifier

N.B. Contents of the boxes under File Name: and Folders: can vary.

28. The anzscc.spc file must be saved into the directory specified when the
coder was initialised, where it will replace the existing version. To do this select
appropriate directory. The pop-up will then change with the folder alongside



the selected directory being displayed as open; in addition the filename
anzscc.spc will also appear in pale grey in the larger box under File Name.

Select L and the following pop-up will appear:

29. Select w&2keas and the settings and changes will be saved and the
ANZSCC Coder will close.

30. Classn Display is the third option. Selection of this optien resuits in the
Classification Display Options screen being presented:

ULt athinr Dhspliy Dptinins

s~ Classn Structure 3 r~Definitions o
: {:None : ! None
L6 em Dot . | @ ltem Delinitions
: " tam Hisrarchy :I?_‘ Accept Cods From
- | € Full Hiararchy :’
# Expandable Hierarchy: S YT I T 10T T |
: i¥: Accept Code From & Nose
: {8 Numeric ndex

{" Allow Sparch
# Confirm Code Accepl
¥ Options Uzer Alterable

HEE Acoept Dods Fram

FY acupss frow Dnfingions |

31.  The function of this screen and its options have aiready been covered
under the heading 3.1.1 File \ New (page 32).
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3.3 The View Menu

32. Selecting View will result in the following "pull-down’ menu being
displayed:

33.  Selecting the first option Classification Structure will display the
Classification Hierarchy screen for any description currently selected. If no

description is currently selected, the Section (1 digit) level of the classification
will be displayed.

34.  Selecting the second option "ltem Definitions’ wili display the
Classification Item Description screen for any description currently selected.

3.4 The Window Menu

35.  Selecting Window will result in the following ‘pull-down’ menu being
displayed:

921100000

§921 --Primary educatiorrse] : o A, :

921100000 ---Preschaool education services

36. Window produces different options at different screens. it provides the
standard WINDOWS Gascade, Tile and Arrange lcons options and shows
which coder screens are activated. It can be used to switch between coder
screens.




3.5 The Help Menu

37. Selecting Help will result in the following 'pull-down’ menu being
displayed:

|

38. The Help menu options provide information on all aspects of the
development and operation of the ANZSCC Coder as weli as the normal
WINDOWS help information.

39. The following example of Help topics is presented when the ‘Contents’
option is selected from the Help Menu:

M Help

{ WinSCM Help Contents

1 This contents lists all Help topics available for
{ the WinSCM [Windows Structured Coding
Methodology) program.

4 To obtain help an any topic, select the

1 relevant item. Press F1 while in the WinSCM
To obtain context sensitive help. To learn how
o use Help, press F1 or choose Using Help
from the Help menu command.

Introduction

Wi B inbrodkiicEon

CToding Spacifisgions

How to...

Craste Coding Speciicstions

Opan Goding Specifications

Bave Coding specificakons

cabons
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40.  Selection of Procedures, the second option of the Help Menu, will
activate the foliowing screen:

{ Coding a Response

{ There are speclific coding instructions for some

4 coding indexes. To view these instructions, select

4 the Coding Instructions Command from the Help Menu
4 . The following is & generc description of the coding

4 process in WinSCM.

The coding process supplied by WINSCM is a simple

{ search/selection process WIinSCM accepts a search

3 string {or strings), and dispiays a fist of kov pivass entries
§ for selection from.

Currently there are three search engines supported by
1 WIinSCM, each allowing a variation on how searching is

performed. 3
; . indexing search erging
. rxach Matah sgarch ansine
: s Zimwchured searelo smgine
Which of these is capable of being used for any one 3 ]

41.  This screen provides a generic description of the coding process in
"WinSCM" (the program which is the basis of the ANZSCC Coder).

42.  Keyboard, the third option of the Help Menu, provides a list of topics
related to the use of the keyboard. Clicking on any topic of interest reveals
more information concerning the topic selected.

WINnSCM Keys

Choose from the following list to review the
keys used in WinSCM:

SUraor Maovermment Hless

[Zigioaeg Fiome Keys

4
Echiling Kevs

Heip Keys

LELER R AR R e R AL




43. Similarly How to Use Help from the Help Menu activates the following
Contents screen:

* Cusmizig Help

.

RS

44  Double clicking on the 'book’ icon displays Help topics organised by
category:

wWindow:s Help

Finding a topic in Help

2] Getting information in a dislog box

.ﬂ Copying information from a Help topic
Printing & Help topic

3 Viewing aiist ollogics you've seen

(i Using tha Find tab
ﬂ Searching for words in a He!p file
‘A1 Searching for phrases in a Help file
i Selecting a Help file to search
A Marki ng topics relevant to a seerch
& Findin gimilar topics

Changing the font and color in & He!p topic

Specifying whether Help stews in front of other windows
Adding & commentto a Help topic

Puting a bookmark in & Help topic
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45.  Clicking on the topic of interest reveals more information on that topic.
Doubie clicking the 'book’ icon will close the 'book'".

46.  The Index window allows searching for the topic of interest within Help
topics available, examples of which are shown in the screen image below:

R ;
alternate mouse button
using o get Help information
using to print Help infermistion
anngtating a Help topic
arranging open windows
bookmarks, adding to Halp topics
button help
character size, changing
colars
Help window colars, changing
command option boxes. using
comments, adding to Help topics
Cantanls tab in Heip. using
context-sensitive Help
{controls. getting Help on
copying

47. The Find window allows searching for specific words and phrases in
Help topics. Simply follow the instructions detaited in the folowing screen:

48. The About Wincoder option simply identifies the Version of the
Computer Assisted Coding System in use.
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